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Take Control ebooks help readers regain some measure of control in an
oftentimes out-of-control universe. Take Control ebooks also streamline the
publication process so information about quickly changing technical topics can be
published while it’s still relevant and accurate. Send comments about this, or any,
Take Control ebook to tc-comments@tidbits.com.

This ebook does not use copy protection because copy protection makes life
harder for everyone. So we ask two favors of our readers. If you want to share
your copy of this ebook with a friend, please do so as you would a physical book,
meaning that if your friend uses it regularly, he or she should buy another copy.
Or if someone has given you a copy you find useful, please buy your own copy at
http://www.tidbits.com/takecontrol/—your support makes it possible for future
Take Control ebooks to hit the Internet long before you’d find the same
information in a printed book. Plus, if you buy the book, we will contact you
should a free update become available.

Although the author and TidBITS Electronic Publishing have made a reasonable
effort to ensure the accuracy of the information herein, they assume no
responsibility for errors or omissions. The information in this ebook is
distributed “As Is,” without warranty of any kind. Neither TidBITS Electronic
Publishing nor the author shall be liable to any person or entity for any special,
indirect, incidental, or consequential damages, including without limitation lost
revenues or lost profits, that may result (or that are alleged to result) from the use
of these materials. In other words, use this information at your own risk.

Any trademarks, service marks, product names or named features that appear in
this ebook are assumed to be the property of their respective owners.

This is a free sample of “Take Control of Upgrading to Panther.”
Click here to buy the full 65 page book for $5! Page 2


http://www.tidbits.com/takecontrol/
http://www.tidbits.com/takecontrol/
mailto:tc-comments@tidbits.com?subject=Upgrading to Panther 1.1 Comment
http://www.tidbits.com/TakeControl/Panther/Upgrading.html

VERSION 1.1 CHANGE LIST

As with any new operating system, Panther was full of surprises—
some good, some not-so-good. Despite the extensive testing
performed by Apple and an army of beta testers prior to Panther's
release, a number of issues have surfaced since the day this ebook was
first published (which was the same day as Panther’s release).
Although it would be impossible to cover every possible problem that
might arise during installation, several concerns have stood out as
affecting a large number of users. This version 1.1 update to Take
Control of Upgrading to Panther helps you deal with them. Here are
the major changes:

« An entirely new section on using FireWire hard drives, some of
which have experienced data loss under Panther

« Information on preventing (or repairing) installation issues
affecting firewalls, printing, AppleTalk, and X11

« Discussion of a RAM problem that can cause installation to fail
« More detailed advice for those who wish to partition a hard drive

« Improved instructions for copying essential files after an Archive
and Install upgrade

 Details on additional software that must be updated to work
correctly under Panther

« Several minor clarifications and additional tips

I made many of the changes in response to feedback from readers,
and I deeply appreciate the comments I've received. Along with the
TidBITS staff, I have been delighted and overwhelmed at the positive
reception readers have given this publication.

FUTURE TidBITS Electronic Publishing may publish minor updates to this
UPDATES ebook to account for errata, updates in covered software, new
information coming to light, or other reasons. Such updates will be
available at no additional charge, and you will be notified of them at
the email address you gave at the time of purchase.
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READING TIPS

This ebook was designed to be read online or printed. Here are a few
tips for enhancing your online reading experience in Adobe Acrobat
and Adobe Reader (we're still learning the tricks for Panther’s
Preview application):

In Adobe Acrobat 5, the Take Control default settings on the View
menu are Fit in Window and Continuous. For most people with
larger monitors, those should be fine. To focus only on reading, in
Acrobat 5, choose View > Full Screen, or in Acrobat 6, choose
Window > Full Screen View. (Press Esc to leave full screen mode.)

You can increase the size of the text by clicking the window’s Zoom
button to make the window as wide as possible, and then choosing
View > Fit Width. You can eke out more horizontal width by
closing the Bookmarks tab (click the Bookmarks tab at the far left
of the Acrobat document window).

You can scroll using keyboard shortcuts in a number of ways (you
may need to click in the main text area before using these
shortcuts). The Page Up and Page Down keys may be the easiest
(and they scroll by screen when you are viewing less than a full
page). The Left and Right arrow keys scroll to the previous and
next page starts.

Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links, as
are URLs and email addresses.

Work with the Bookmarks tab showing so you can always see and
jump to any main topic by clicking the associated bookmark.

Remember that you can always print if paper is your preferred
reading medium.
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INTRODUCTION

Mac users can be divided into two main categories. On the one hand,
there are the early adopters—those who buy every new gadget and
install every new software update the moment it’s released. These are
often the people who wait in line for hours to be among the first
customers at a new Apple Store or to get the best seats at a Macworld
Expo keynote speech. The other type of Mac user is more cautious,
waiting to see what experiences other people have before taking
chances with new products. These users, though no less fanatical
about their Macs, are often the ones who hold onto old hardware even
when it’s well past its prime, and who live by the motto, “If it ain’t
broke, don’t fix it.”

When it comes time for a major upgrade to the Mac OS, the early
adopters often rush to upgrade their systems, only to discover
unexpected problems that they then must spend hours or days trying
to solve. (These experiences, of course, turn some early adopters into
cautious users.) The cautious users, while perhaps envious of the new
features their friends have, are not envious of their problems, and
may choose to wait until the x.0.1 or x.0.2 release before upgrading.

I am a recalcitrant early adopter; I muddle through problems and
figure out the solutions so cautious users don’t have to. With Apple’s
release of Mac OS X 10.3 Panther, I have access to some remarkable
capabilities that have already made my computing life a lot easier
and more enjoyable. If you, too, are an early adopter, I hope my
experiences will save you time, effort, and aggravation as you
upgrade. And if you're a more cautious user, perhaps this ebook

will inspire you to jump in sooner and take control of your Panther
upgrade. You'll be glad you did.
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CHECK YOUR HARDWARE FOR COMPATIBILITY

If your Mac was manufactured within the last four years or so, you
almost certainly have adequate hardware to run Panther. For older
machines, the situation is more complex. In particular, not every
computer that can run Jaguar can also run Panther.

WARNING Planning to use an external FireWire drive with your Panther system?
Be sure to read Update or Remove FireWire Hardware, later in this
section.

Processor and USB Support

For starters, Panther requires a PowerPC G3, G4, or G5 processor and
built-in USB. So any iMac, eMac, iBook, PowerBook G4, Power Mac
G4 (including the Cube), or Power Mac G5 qualifies—as long as it has
enough RAM (see just ahead under “RAM”). The original beige Power
Macintosh G3 and the Power Macintosh G3 All-In-One cannot run
Panther, but all newer desktop machines can.

The situation is murkier with G3 PowerBooks. The original (“Kanga”)
PowerBook G3, which lacks factory-installed USB ports, cannot run
Panther. Neither can the “Wallstreet” PowerBook G3, for the same
reason (even though it can run Jaguar). However, the “Lombard”
PowerBook (Bronze Keyboard) and the “Pismo” PowerBook
(FireWire) both meet Apple’s minimum requirements.

Note that simply adding a USB card to an unsupported Mac will not
make it Panther-compatible; the installer will refuse to run.

Tip XPostFacto is a utility that enables Jaguar to be installed on some
unsupported systems. The author is currently working on an update,
which he hopes will enable Panther to run on both beige G3 and
Wallstreet PowerBook G3 computers. To check on the current status
of XPostFacto, visit the Other World Computing Web site.
http://eshop.macsales.com/OSXCenter/XPostFacto/framework.cfm
?page=XPostFacto.html
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BACK UP YOUR DATA

System upgrades, because they affect so many parts of your hard disk,
and at such a low level, are times when problems are especially likely
to occur. So I can’t emphasize this strongly enough: before upgrading,
back up your data. The time you spend now may save you countless
hours of frustration later.

If you already follow a regular backup regimen (good for you!), verify
that all your important files are freshly backed up and test your
backup by seeing if you can successfully restore a few representative
ones. (For a list of the files you should pay particular attention to, see
“Backing up your personal files,” next.) If not, this is a perfect time to
start. A backup utility will make the process much easier. Every
serious Mac geek I know (including myself) uses Dantz’s Retrospect
for backups (http://www.dantz.com/). There are a number of other
alternatives, including Apple’s own Backup utility for .Mac members
(though it doesn’t come close to Retrospect’s power).

Whether or not you already use a commerecial utility for backups, I
recommend that before upgrading to Panther, you also clone your
entire hard disk—make a complete, bootable copy—just to be safe.
(This is especially important if you erase your disk when installing
Panther.) See “Backing up your system” (a few paragraphs ahead) for
instructions.

Backing up Your Personal Files

If you always store data in its default location, most or all of your
personal files are in your home folder, located in your user’s folder in
/Users. This includes documents, photos, movies, and music files as
well as preferences, fonts, AppleScripts, saved email, Address Book
and iCal entries, and many third-party preference panes—plus the
items that appear on your Desktop. So any thorough backup should
include your entire home folder. (If your machine is configured for
multiple users, be sure each user’s home folder is backed up.) If you
have stored any personal files outside your home folder, be sure to
include those in the backup as well.
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Backing up Your System

Even if all your documents are backed up, you should consider
making a bootable backup of your entire disk. In the event that you
upgrade to Panther and encounter serious problems (such as an
essential piece of software that does not work under the new
operating system), you will want to return to your old system, and a
bootable copy of that system will make the process easier. (See How
to Downgrade for details.) Under Mac OS X, you cannot simply copy
your System folder onto a new volume and have a bootable backup.
You could learn a long sequence of Unix commands to do this, but an
easier way is to use Retrospect or Mike Bombich’s free Carbon Copy
Cloner (http://software.bombich.com/ccc.html).

You will need a second hard drive (which could even be an iPod), a
large network drive, or a DVD burner to clone your entire system.
Although you can also clone your system to a separate partition on
your internal hard disk, this is less safe because a hardware problem
could make all your partitions inaccessible.

Carbon Copy Cloner and Retrospect include complete instructions, so
I won’t repeat all the steps here. For best results when using Carbon
Copy Cloner, I recommend selecting the Repair Permissions Before
Cloning and Make Bootable options in the Permissions dialog. In
Retrospect, use the Duplicate button on the Immediate tab to clone
your hard disk.
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PERFORM A CUSTOMIZED UPGRADE

With your hardware checked, your data safely backed up, and plenty
of free disk space, it’s time to beginthe upgrade. Insert the first
Panther CD and double-click the Install Mac OS X icon. In the
window that appears, click the Restart button, and enter your
administrator password when prompted. Your computer restarts
from the CD and the installer runs.

Tip In the unlikely event that your computer does not restart from the
CD, try the Computer Won't Start steps in the “Troubleshoot Upgrade
Problems” section, near the end of this ebook. This section also has
suggestions for solving a variety of other problems you might
encounter during installation.

The installer asks you to choose a language, then presents you with a
Welcome screen, a Read Me file, and a Software License Agreement. I
assume you know how to deal with all those screens.

Select a Destination

The next screen asks you to select which volume to install Panther
onto. If you have only one volume, this is an easy choice; if you have
multiple partitions and/or disks, be sure to select the correct one. The
installer tells you if there is sufficient disk space; if not, it tells you
how much more you need. (You can reduce this amount by
deselecting optional software packages in the next step.) Then...

Stop!

Do not click Continue, do not pass Go, do not collect $200. Not even
if your disk has plenty of space. Before you go on to the next step,
click the Options button at the bottom of the window to display a
sheet where you can choose one of up to three upgrade methods. This
choice is crucial to your future happiness!

NoOTE If you use the Panther upgrade CDs obtained through the Mac OS X
Up-to-Date program, you can install Panther only onto a volume that
already has some version of Mac OS X installed. If you need to put
Panther on another volume, install Jaguar there first.
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TROUBLESHOOT UPGRADE PROBLEMS

Even if you diligently followed all the instructions in this ebook, you
might encounter problems while upgrading. I can’t anticipate every
difficulty you may have (or provide solutions in every case), but here
are some of the most likely issues and how to deal with them.

Computer Won't Start Up from the CD...

After launching the installer and restarting, if your computer will not
boot from the installation CD, do this:

1.

Shut down your computer and wait for a few seconds. If the CD
was ejected, make sure it is free of smudges, scratches, and
fingerprints, and reinsert it.

. Press the Power button, and immediately hold down the C key to

force the computer to boot from the CD. If this doesn’t work...

. Restart your computer, this time holding the Option key. Icons

representing each valid startup volume will appear on the screen.
Click the icon for the installation CD, then click the right arrow. If
this doesn’t work...

. Shut down your computer, then remove all peripherals, network

cables, and anything else attached to your computer except the
Apple-supplied keyboard, mouse, and display. (You may also need
to remove any third-party video and PCI card(s) and even, in rare
cases, extra RAM modules.) Then go back to Step 2 (and Step 3 if
necessary). If this doesn’t work...

. Zap your PRAM. To do this, restart, and immediately hold down

the Command, Option, P, and R keys. When you hear the second
startup chime, release the keys and immediately press the C key as
in Step 2. If this doesn’t work...

. Contact Apple. Start with the Support section of the Apple Web

site; if that does not contain the help you need, contact AppleCare
(if applicable) or visit your local Apple Store for assistance.

You should be able to restart from the Panther Install CD by the time
you finish these steps.
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TAKE CONTROL OF PANTHER: THE SERIES

Take control of computing with the Take Control series of highly
practical, tightly focused electronic books! Written by leading
Macintosh authors, edited by TidBITS, and delivered to your
electronic doorstep within moments of “going to press,” Take Control
ebooks provide just the technical help you need.
http://www.tidbits.com/takecontrol/

Other available Take Control ebooks:

Take Control of Customizing Panther, by Matt Neuburg
http://www.tidbits.com/takecontrol /panther/customizing.html

Additional ebooks planned for release in 2003 include:
Take Control of Using the Finder in Panther

Take Control of Users and Accounts in Panther

Take Control of Sharing Files in Panther

Take Control of .Mac

With your support, we plan to publish a number of additional ebooks
in early 2004.
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SHAMELESS PLUG

Joe’s book, 50 Fast Mac OS X Techniques
(Wiley, 2003), was written for Jaguar, but
most of the techniques are equally useful
under Panther. This book shows you how to
enhance, extend, and customize Mac OS X.
You'll learn to use Terminal like a Unix geek,
connect to the Internet using your Bluetooth
cell phone, master the use of Mac OS X’s
handwriting- and voice-recognition features,
automate repetitive tasks, and much more.

50 sast
TECHNIQUES

You can learn more about the book, read sample pages, search its
contents, or place an order by visiting Amazon.com:

http://www.amazon.com/exec/obidos/redirect?tag=interesthingo-
20&path=tg/detail/-/ 0764539116
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ABOUT TidBITS ELECTRONIC PUBLISHING

Take Control ebooks are a project of TidBITS Electronic Publishing.
TidBITS Electronic Publishing has been publishing online since 1990
when co-publishers Adam and Tonya Engst first created their online
newsletter, TidBITS, about Macintosh and Internet-related topics.
TidBITS has been in continuous, weekly production since then, and it
is the leading online Macintosh newsletter.

To stay up to date on Mac OS X 10.3 Panther and other Macintosh
topics, be sure to read TidBITS each week. At the TidBITS Web site
you can subscribe to TidBITS for free, participate in TidBITS Talk
discussions, or search 13 years of news, reviews, and editorial
analysis.

Adam and Tonya are well-known in the Macintosh world as writers,
editors, and speakers, and they have written innumerable online and
print publications. They are also parents to Tristan, who is almost five
and thinks ebooks about trains, clipper ships, and dinosaurs would be
cool.

TidBITS Web site: hitp://www.tidbits.com/
Adam’s home page: http://www.tidbits.com/adam/

Tonya’s home page: http://www.tidbits.com/tonya/
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